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Vitec Group Communications

SOFTWARE LICENSE

IMPORTANT: CAREFULLY READ THE FOLLOWING BEFORE USING THIS SOFTWARE.
USING THE SOFTWARE INDICATES YOUR ACKNOWLEDGMENT THAT YOU HAVE READ
THE FOLLOWING AND AGREE TO ITS TERMS.

IF YOU DO NOT AGREE, RETURN THE SOFTWARE COMPLETE TO VITEC GROUP
COMMUNICATIONS LIMITED OR CANCEL THE INSTALLATION.

THIS IS YOUR PROOF THAT YOU HAVE A VALID LICENSE. PLEASE TREAT IT AS
VALUABLE PROPERTY.

VITEC GROUP COMMUNICATIONS LIMITED OR VITEC GROUP COMMUNICATIONS, INC.,
as the case may be (hereinafter referred to as “VGC”), offers you this storage media
containing a computer program and files (the “SOFTWARE”) and offers to grant to you a
non-exclusive and non-transferable License to use the Software on the following terms.

Any new revision or update of the Software provided by VGC to Customer under this
License shall be governed by the terms and conditions of this License.

1. APPLICATION

a. These terms supersede all prior agreements representations and understandings
between you the Customer and VGC and their authorised representatives relating to the
subject matter hereof (i.e., the Software) but shall otherwise be subject to Vitec Group
Communications Terms and Conditions, as amended from time to time. For the avoidance
of doubt, in the event of conflict, these terms shall prevail.

b. No variation to these terms, nor any other terms or conditions proposed by you, shall be
of any effect unless recorded in a written document signed by VGC. You confirm that any
statement made to the contrary by you or on your behalf shall not apply to this License.

c. You confirm that you are not relying on any statement made by or on behalf of VGC, other
than statements recorded in a written document signed by VGC.

d. VGC and its licensors reserve all rights not expressly granted to you. VGC's licensors are
intended third party beneficiaries of this Agreement and have the express right to rely upon
and directly enforce the terms set forth herein.

e. You agree that the Software belongs to VGC and its licensors. You agree that you neither
own nor hereby acquire any claim or right of ownership to the Software or to any related
patents, copyrights, trademarks or other intellectual property. VGC and its licensors retain all
right, title and interest in and to the Software and all copies thereof at all times, regardless of
the form or media in or on which the original or other copies may subsequently exist. This
license is not a sale of the original or any subsequent copy.
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2. COPYRIGHT

a. The copyright and all other rights in the Software produced by VGC shall remain with
VGC or its suppliers. You must reproduce any copyright or other notice marked on the
Software on any copies that you make.

3. YOU MAY:

a. Use the Software only on a single PC. If you wish to use the Software on more than one
PC you must contact VGC and if required purchase further Licenses;

b. Make one copy of the Software for archival or back-up purposes, and;

c. Transfer the Software to an end user of a VGC product, only if you have made it clear to
VGC that you are not the end user and you assign all of your rights under this License and
make no use of the Software yourself.

4. YOU MAY NOT:

a. Use the Software or make copies of it except as permitted in this License;

b. Publish or distribute the computer images, sound files or fonts included with the Software
as computer images, sound files or fonts;

c. Translate, reverse engineer, decompile or disassemble the Software, except to the extent
the foregoing restriction is expressly prohibited by applicable law;

d. Rent, lease, assign or transfer the Software except as set out above; or
e. Modify the Software or merge all or any part of the Software in another program.

5. TERM:

a. This License shall continue for as long as you use the Software. However, it will terminate
if you fail to comply with any of its terms or conditions. You agree, upon termination, to
destroy all copies of the Software. The Limitations of Warranties and Liability set out below
shall continue in force even after any termination.
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6. LIMITED WARRANTY:

a. VGC warrants that the storage media in this Software will be free from defects in
materials and workmanship for 90 days from the date you acquire it. If such a defect occurs,
return it to us at the address below and we will replace it free. This remedy is your exclusive
remedy for breach of this warranty.

b. After the initial 90 days, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, PERFORMANCE, ACCURACY, RELIABILITY, OR NON-
INFRINGEMENT OF THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS. This
constitutes an essential part of this License.

7. LIMITATION OF LIABILITY:

a. For the avoidance of doubt, all conditions imposed by law covering matters such
as fitness for purpose, compliance to description, negligence and quality are
expressly excluded from this agreement and you agree to accept the foregoing
warranty in lieu of all such items.

b. IN NO EVENT SHALL VGC BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF
BUSINESS, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS, OR
FOR INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY, MULTIPLE, PUNITIVE OR
CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER BASED ON CONTRACT, TORT
(INCLUDING WITHOUT LIMITATION, NEGLIGENCE), WARRANTY, GUARANTEE OR
ANY OTHER LEGAL OR EQUITABLE GROUNDS, EVEN IF VGC HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.

c. The warranty is personal to you (or end user if you have made it clear that you are not the
end user) and may not be transferred (except as permitted expressly above).

d. VGC shall not be a liable for failure to perform any obligation to you where such failure is
due to circumstances beyond VGC'’s reasonable control.

e. VGC offers extended warranties and, if you are not satisfied with the above, you
should consider such warranties or consider separate insurance.

8. RESTRICTED RIGHTS:

If this Software is acquired by or for the U.S. Government then it is provided with Restricted
Rights. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set
forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause
at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Commercial Computer
Software - Restricted Rights at 48 CFR 52.227-19, or clause 18-52.227-86(d) of the NASA
Supplement to the FAR, as applicable. Contractor/manufacturer: Vitec Group Communications
Limited, 7400 Beach Drive, Cambridge, England CB25 9TP or Vitec Group Communications
LLC, 850 Marina Village Parkway, Alameda, CA 94501.
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9. OTHER ISSUES:

a. Any failure by VGC to insist on its strict rights under this Agreement shall not be deemed
to be a waiver of those (or any other rights) and only a duly executed written release shall
constitute such a waiver.

b. If any of these conditions is deemed invalid or unenforceable the remainder shall be
unaffected.

c. VGC's dealings with you shall be governed by English law if you are resident in the EMEA
region and California law if you are resident elsewhere. The federal and state courts of
California for Non-EMEA Customers and English Courts for EMEA Customers shall have
exclusive jurisdiction to adjudicate any dispute arising out of this Agreement.

d. If any document is written in more than one language the English text shall prevail.

e. Capitalized terms not defined herein shall have the meanings set forth in Vitec Group
Communications' Terms and Conditions, as amended from time to time.

Vi
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INSTALLATION

CLEAR-COM CONCERT
INTERCOM SOFTWARE

Clear-Com Concert is a multi-user conferencing and intercom
application. It enables business users and collaborative
workgroups to instantly and reliably intercommunicate. This
manual describes how to install, navigate, and use Concert. The
minimum recommended system requirements are:

Interface-enabled client

Processor: Intel® Pentium® 4 Processor (2.8GHz) or comparable

Either client
RAM: 512GB
Hard Drive: 60MB free hard disk space
Network Card: 100MB Ethernet interface or better
OS: Windows XP or Windows Vista
Audio Device: Plantronics USB headset (recommended)
e Other compatible headsets include:
— Plantronics .Audio 400 USB (best)
— Plantronics .Audio 470 USB
— Plantronics .Audio 750 USB

— Jabra

— USB conference phones may also be used with
Concert.
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INSTALLING CONCERT

1. To begin the installation procedure, double-click on the self-
extracting Concert installation file (provided by the system
administrator).

Concert-2,5.0,a34-setup.exe
Concerk Setup
ClearCom

This will launch the Concert Setup Wizard:

- Setup - Concert Qlil@

Welcome to the Concert Setup
Wizard

Thiz will ingtall Concert 2.5.0.34 on wour computer.

It iz recommended that you close all other applications before
continuing.

Click Nest to continue, or Cancel to exit Setup.

[ Mext> |[ Cancel

Figure 1-1: Concert Setup Wizard

2. Click Next to proceed with the setup process.
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The User Information screen appears:

== Sotup - Concert

Uszer Information
Pleaze enter your information.

User Mame:

|[enter your user hame] |

Organization;

|[enter your organization] |

l < Back ” Mext » ][ Cancel

Figure 1-2: Concert Setup User Information

3. Enter your User Name and Organization (if applicable).

4. Click Next to enter the installation location.

== Sotup - Concert

Select Destination Location ~ l
Where should Concert be installed? /
(R
._J Setup will install Concert into the fallowing folder.
To continue, click Mest. If you would like to select a different folder, click Browse.
I:i:"-.F'r-:u:lrarn Filez\Conce | [ Browze...
At least 20.7 MB of free disk zpace iz required.
l < Back ” MHest » ] [ Cancel

Figure 1-3: Concert Default Installation Directory

Clear-Com Communication Systems
Clear-Com Concert v2.5.0 Client User Manual 1-3



5. Specify the installation folder for the Concert application.

It is recommended that you accept the default location
(C:\Program Files\Concert), if possible. The amount of disk space
required for the installation will be displayed.

Note: You should ensure that the required disk space is available
before continuing with the installation (additional space may be
required by the client after installation).

6. Click Next to continue.

= Sotup - Concert

Select Start Menu Folder H
Where should Setup place the progranm's shortcuts? =
Setup will create the program'z shortcuts in the following Start Menu folder.

To continue, click Mesxt. IF you would like to zelect a different folder, click Browsze.

Browvsze...

[] Dan't create a Start Menu folder

< Back " Mext » ][ Cancel

Figure 1-4: Concert Start Menu Name

7. Specify the name of the shortcut that will be placed in the Start
Menu folder.

8. Click Next to continue.

1-4
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The Select Additional Tasks screen appears:

== Sotup - Concert

Select Additional Tasks
‘which additional tazks should be performed?

Select the additional tasks pou would like Setup to perfarm while instaling Concert, then
click Mext.

Additional icons:
Create a desktop icon
Create a Quick Launch icon

< Back ” Mext » ][ Cancel

Figure 1-5: Concert Start Icons

9. If you want to create either a desktop shortcut or a “Quick
Launch” icon, select the appropriate checkboxes.

== Sotup - Concert

Ready to Install ~ l
Setup is now ready to begin installing Concert on your computer,

Click Install to continue with the installation, or click Back if you want ta review or
change any zettings.

Usger information: s
Emily Johnzon
Clear-Com

D estination location:
C:AProgram Filez\Concert

Start Menu folder;
Concert

Additional tagks:
Additional icong:
Create a desktop icon hd

l < Back ” [nztall ][ Cancel

Figure 1-6: Concert Installation Complete Confirmation
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10. Click Install to proceed with the installation process (or click
Back to change your entries).

A progress bar indicates the progress of the installation. As soon
as the installation completes, the Completing the Concert Setup
screen appears:

*= Setup - Concert E“EE]

Completing the Concert Setup
Wizard

Setup has finizhed instaling Concert on your computer. The
application may be launched by zelecting the installed icons.

Click. Finigh to exit Setup.

Launch Concert

Figure 1-7: Concert Install Completion

11. If you want to start the application immediately, select the
Launch Concert checkbox.

12. Click Finish to exit the installation wizard.

When the Concert application is started for the first time, some
configuration will be necessary. The configuration procedure is
described in the following section.

1-6
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CONFIGURING CONCERT

Once the Concert application has been installed, it will need to be
configured for the audio devices available on your computer. You
will also need to specify your notification and server options.

When you start Concert for the first time, a device configuration
window will display automatically, requiring you to set up your
audio device profiles (i.e., primary sound device, ringing sound
device, and secondary sound device).

CONFIGURING THE PRIMARY SOUND DEVICE

The primary sound devices are the default audio input
(microphone) and output (headset or speakers) devices that will
be used by Concert.

Clear-Com Concert™ Configuration E|
@ 418/ Primary Sound Device (Default)
General fudioin [1158 Audia Device Bl rrer: EERREEE

Audio out {158 Audio Device v || Pref: [USE Audio Device

=

Devices IDT Audio

— o=y Device, ..

Ringing Sound Device

&L

Notifications | Rringing | 1sE Audio Device j[ Pref: |USB Audic Device
ﬁ Test RiNGing. .. |
Audio - i
{=b Secondary Sound Device
@ Audioin | 1UsE Audio Device v || Pref: [USE Audio Device
Server fudio out [1158 Audia Device j[ Pref: |USB Audio Devica
' Test Secondary Device settings... ]

Interfaces Refresh [ Save ] [ Cancel

Figure 1-8: Configuring Primary Sound Device

1. From the Audio in dropdown list (in the Primary Sound Device
area), select your preferred audio input device.

Note: The device dropdown lists display only the hardware devices

that are currently connected, installed, and enabled on your
computer.

Clear-Com Communication Systems

Clear-Com Concert v2.5.0 Client User Manual 1-7



Note:

For each item on this screen, the first device you select from a
list will be automatically set as the preferred device (displayed
to the right of the item).

From the Audio out dropdown list, select your preferred audio
output device.

In the above example, the same device was selected for both the
primary input and output device.

3.

Note:

To test the primary sound devices configuration, click Test
Primary Device. This will create a local loopback channel
directing any input audio to the specified output device.

Try speaking a few words to verify that the configuration is
working properly.

The label on the Test Primary Device button changes to Stop
Test.

To stop the test, click Stop Test.

Preferred Device Operation

Concert will attempt to use the preferred audio input and output
devices whenever you log in. If a device is not available, Concert
will try to use another device within the list, such as an onboard
sound card.

1-8
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CONFIGURING THE RINGING SOUND DEVICE

Next, you will need to specify an audio device to output the “ring”
sound when a call from another Concert user is received. This is
usually the same output device selected above but could also be
an external speaker, if desired.

Clear-Com Concert™ Configuration

(@2

General

=

Devices

&L

Motifications

&

Audio

(@2

Server

Interfaces

b Prirmary Sound Device (Default)

Audioin | 1UsE Audio Device v || Pref: [USE Audio Device

Audio out |USB sudio Device j[ Pref: ]USB Audio Device

Test Primary Device... ]

Ringing Sound Device

Ringing | 1UsE Audio Device || Pref: [UE Audio Device

U3E Audio Device

b/ Secondary Sound Device

Audio in |USB sudio Device j[ Pref: ]USB Audio Device

Audio out {158 Audio Device v || Pref: [USE Audio Device

Test Secondary Device settings... ]

Save

Refresh [

|| conce

Figure 1-9: Ringing Device Configuration

1. From the Ringing dropdown list (in the Ringing Sound Device
area), select your preferred ringing device.

Note:

If the selected ringing device is later disconnected for some

reason, Concert will attempt to use another device from the list
when a call is received.

2. To test this device, click Test Ringing.

Note:

3. To end the test, click Stop Test.

The label on the Test Ringing button changes to Stop Test.
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CONFIGURING THE SECONDARY SOUND
DEVICE

The last configuration step is to specify the preferred secondary
sound device configuration. For example, your preferred primary
device could be your headset, and your preferred secondary
device could be a personal duplex speakerphone for hands-free
audio. This device will be enabled automatically when you switch
to the secondary device on the client.

Clear-Com Concert™ Configuration E|
@ &b Primary Sound Device (Default)
General Audiain |USB udio Device j[ Pref: |USB Audic Device
m Audio out |1UsE Audio Device || Pref: [UE Audio Device
Devices Test Primary Device... ]
8 Ringing Sound Device
Motifications Ringing |IDT Audio j[ Pref: ]USB Audio Device
ﬁ Test RiNGing. .. |
Audio - )
4=/ Secondary Sound Device
@ Audioin | UsE Audio Device j[ Pref: |USB fudio Devica
Server Audio out 1158 Audio Device j[ Pref: |USB Audic Device

LISE Audio Device
[IDT Audio

--;—5- settings...
Interfaces Refresh [ Save l [ Cancel

Figure 1-10: Configuring Secondary Sound Device

1. From the Audio in dropdown list (in the Secondary Sound
Device area) select your secondary audio input device.

Note: The device dropdown lists display only the hardware devices

that are currently connected, installed, and enabled on your
computer.

2. From the Audio out dropdown list, select the secondary audio
output device.

3. Click Test Secondary Device settings to test the secondary
sound device configuration.

Note: The label on the Test Secondary Device settings button

changes to Stop Test.

1-10
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4.

Note:

If the audio test of the secondary sound device is satisfactory,
click Stop Test.

Once all three configurations have been completed and tested,
click Save (or click Cancel to exit the configuration without
saving).

You can madify the client audio or server configuration at any
time through the Concert menu (Config > Devices).

USER CONFIGURATION OPTIONS

In addition to Devices, there are five other configuration
categories:

Note:

e General

¢ Notifications
e Audio

e Server

¢ Channels (displayed only if the administrator has granted
channel configuration rights to the user).

The default configuration for General, Notifications, and
Audio should be sufficient for normal use. However, the
Concert server address will need to be specified within the
Server option before a connection to Concert can be
established. Therefore you may skip to the Server section at
this time.

Clear-Com Communication Systems
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General Configuration Options

The General configuration window provides you with control
options for application startup, automatic call answering, and
cleanup of history files.

1. To access this window, click on the General icon.

Clear-Com Concert™ Configunation

@ Startup...
[ Start Clear-Com Concert™ when computers skart:
General v Sign me in when Clear-Com Concert™ starts
m Autornatic call answering
(+ Disabled
Devices " Enable automatic answer on all incoming calls
" Enable automatic answer on incoming calls Fram, .,
8 Chagse contacts Anzwer calls fom..,
Notifications
Audio
@ Add Remove
Server History
' Clear Event History l [ Clear Chat Archives l W archive Chat messages
Interfaces [ Save l [ Cancel
Figure 1-11: General Configuration Options
Startup...

2. Inthe Startup area, you can specify that you want to
automatically start and/or log in to Concert whenever your
computer starts.

3. If you prefer to start and log in to Concert manually, leave
these checkboxes blank.

Automatic Call Answering

Note: You must be online to configure the third option listed below:

4. Inthe Automatic Call Answering area, select the appropriate
option:

e Disabled
e Enable automatic answer on incoming calls

e Enable automatic answer on incoming calls from...

1-12
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5. If you select the last option, you will need to specify the
contacts from which to auto-accept calls:

a. Inthe Choose contacts... list, select one or more contacts
(use <Shift>+click or <Ctrl>+click to select multiple
contacts).

b. Click Add to move these contacts to the Answer calls
from... list.

History

The History area provides a means of removing old event and
chat history files (click the appropriate button).

Enabling chat message archiving allows you to display past
conversations with another user within the chat window.

6. Once the settings are satisfactory, click Save (or click Cancel
to abandon the changes).

Notification Options

Within the Naotification configuration page, you can select the
events that will generate a notification in the task bar area. You
can also specify the transparency level of the message and how
long it will remain visible.

1. To access this page, click on the Notifications icon.

Clear-Com Concert™ Configuration E|
@ Motify me when contact..,
[ is available
General [ goes offline

[ status has changed

v calls me

=

[¥ statts a chat with me

Devices
¥ sends me chat messages

Duration (seconds)

&

20
Motifications "

Transparency (%)

&

25 90
Audio ¥
Server
Interfaces Preview, .. [ Save l [ Cancel

Figure 1-12: Notification Options

Clear-Com Communication Systems
Clear-Com Concert v2.5.0 Client User Manual 1-13




Note:

In the Notify me when contact... area, select the appropriate
options.

In the Duration area, drag the slider to specify the number of
seconds a natification will remain visible (defaults to 5
seconds).

In the Transparency % area, specify the transparency of the
message (defaults to 25 percent).

To test the settings, click Preview.

Once the settings are satisfactory, click Save (or click Cancel
to abandon the changes).

If you click Cancel, any changes you have made in any of the
configuration pages will be lost.

1-14
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Note:

Audio Options

The Audio configuration dialog facilitates the configuration of more

advanced audio Quality of Service (QOS) settings.

Simple mode allows you to perform an easy setup of the
connection, while advanced mode is reserved for experienced

users or administrators.

Simple Mode

1. To access the Audio configuration page, click on the Audio

icon.

Clear-Com Concert™ Configuration E|
@ v simple Mode
MNetwork Settings
General
Concert Metwork |W.¢\N ﬂ
m [v Get Eclipse Mebwork From server (default)
Eclipse Metwark
Devices | J

Cptions
8 Echa Cancel r
Notifications Naise Filter | Waice Activity Detection  [v
Aubo Gain Contral v

Audio Buffer Mediumn

(e

Server

Interfaces [ Save

|| cance

Figure 1-13: Simple Mode Audio Options

2. Towork in simple mode, select the Simple Mode checkbox.

3. Inthe Network Settings area, specify the type of network
connection that best describes your network environment (the
default value is WAN). If you are not sure which setting to use,

ask your system administrator.

problems.

Be mindful that an incorrect configuration may cause audio

e LAN: You select this setting when you use Concert on
your corporate LAN (same office) and you have high and

stable bandwidth available
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e WAN: You select this setting when you use Concert on a
corporate WAN (controlled network environment), however
your bandwidth may be lower between two offices or sites

e INTERNET: You select this setting when you use Concert
on the Internet (uncontrolled, unstable and low bandwidth
available), example at home, or remote site.

Note: The LAN setting sets the audio sampling rate at a higher rate
resulting in very high audio quality. However, it uses more
bandwidth. The INTERNET setting sets the audio sampling
rate at a much lower rate resulting in a lower audio quality.
However, it uses less bandwidth.

4. Inthe Options area, you can configure various Quality of
Service settings to reduce latency, echo, and improve the
overall audio quality:

e Echo Cancel: Reduces echo which can be caused by the
use of a speakerphone, being in close proximity to other
participants, or possibly a high speaker volume on the
headset (default: Disabled).

Note: Itis strongly recommended that you use USB devices that
provide built-in echo cancellation.

¢ Noise Filter/Voice Activity Detection: Reduces
background noise and enables the microphone when
speech is detected (default: Enabled).

e Auto Gain Control: Auto adjusts microphone gain
(default: Enabled).

e Audio Buffer: Adjusts the Windows Sound Channel
Buffer. This improves audio quality. For Windows Vista,
level 9 is recommended; for slow computers, level 6 is
recommended. Note that this will also increase audio delay
(default: Medium).

Clear-Com Communication Systems
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Advanced Mode

Note: This mode should be used by advanced users only.

1. Todisplay the advanced mode options, deselect the Simple

Mode checkbox.

Clear-Com Concert™ Configuration

Noti

S

(o

General

&

Interfaces

[ Simple Mode

Bandwidth Settings

X

Bandwidth |Medium

¥

Options

Devices
IMin Jitker {Concert) | 60 Max Jitker (Concert) | 200
Echo Cancel I

Noise Filter | Woice Activity Detection v

fications Loss Protection Laow hd

Aubo Gain Contral v

Medium =

Audio Buffer

erver

oo |

[ Cancel

2.

Figure 1-14: Advanced Audio Options

In the Bandwidth Settings area, choose the appropriate
bandwidth option based on the bidirectional speed of the

network that the Concert system is using.

Note: The bandwidth selection is equivalent to the Network Settings

in Simple mode.

In the Options area, you can configure various Quality of
Service settings to reduce latency, echo, and improve the

overall audio quality:

e Jitter: Smoothes out the audio in high-latency
environments (default: 60ms-200ms).

e Echo Cancel: Reduces echo which can be caused by the
use of a speakerphone, being in close proximity to other
participants or possibly a high speaker volume on the

headset (default: Disabled).

Clear-Com Communication Systems
Clear-Com Concert v2.5.0 Client User Manual

1-17



e Noise Filter/Voice Activity Detection: Reduces
background noise and enables the microphone when
speech is detected (default: Enabled).

e Loss Protection (Forward Error Correction—FEC): This
should be enabled if your network is experiencing packet
loss (default: Low).

e Auto Gain Control: Auto-adjusts microphone gain
(default: Enabled).
e Audio Buffer: Adjusts the audio buffer size for Windows:

— Higher settings increase latency but can resolve
issues with choppy audio.

— Lower settings decrease latency but may cause
audio quality issues.

— The performance level of the PC will also be a factor
in determining the correct audio buffer setting.

4. Once the settings are satisfactory, click Save (or click Cancel
to abandon the changes).

Clear-Com Communication Systems
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Server Options

The Server settings allow you to specify the Concert server to
which you will connect.

1. To access the Server configuration page, click on the Server

icon.

Clear-Com Concert™ Configuration

(o

&

Notifications

7

Audio

(e

Server

Interfaces

Login Server

Login Server | concert.[rmycompanyname].com

General
m Advanced =3
Devices

X

Save

|| cance

Figure 1-15: Login Server Only

2. Inthe Login Server field, enter the address (IP address or

Note:

hostname) of the Concert server specified to you by the
system administrator.

If the system administrator has provided you with the Concert
server address only, then only this field needs to be
completed. Otherwise, proceed to the Advanced Options
section below.

Once the settings are satisfactory, click Save (or click Cancel
to abandon the changes).
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Clear-Com Concert™ Configuration

General

Devices

Notifications

Interfaces [

X

Login Server

(e

Login Server | concerk. [mycompanyname].com

m Advanced <<

Login Server Park

a001

Media Server
IV specify a Media Server different than Login Server

&

Media Server | rmcancert, [mycompanynarme], com

a001

Media Server Port

7

Audio Eclipse Parameters
Eclipse Access DISABLED
Eclipse Status Disconnected
Login Marne
Login Server
Media Server

Server

Save ] [ Cancel

Figure 1-16: Login and Routing Server

Advanced Options

1.

If the system administrator has specified settings in addition to
the Login server address, then click Advanced>> to specify
these advanced media server settings.

Update the Login Server Port, if specified differently by your
system administrator.

Select the Specify a Media Server different than Login
Server checkbox.

Enter the address (IP Address or hostname) of the Concert
Media Server specified by the system administrator. The
media server routes the audio packets to other clients
connected within the Concert system.

Update the EMS Media Server Port, if specified differently by
your system administrator.

An example of a Concert system with two media servers but only
one login server is shown in Figure 1-17, below.

1-20
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SERVER1

SERVER1.COM

SERVER2

SERVER2.COM

User Database
CONF 3 S——1 Server
- Users Login here
|

Figure 1-17: Example of Split-Site Concert Configuration

|

|

|

|

|

:

|

|

|

Local Router — : Local Router —
Routes the Audio |  Routes the Audio
IP Packets | IP Packets

|

|

I |
|

|

|

a4 |
|

|

|

|

|

The configuration page also displays the Eclipse access
parameters. These parameters show whether the client has been
granted access to an Eclipse system by the system administrator.

Note: These parameters are not editable within the client.

Note: The Eclipse connection parameters for the Intercom panel
mode must initially be set up in EMS. Contact your system
administrator for assistance.

6. Once the settings are satisfactory, click Save (or click Cancel
to abandon the changes).
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Interface Options

The Interfaces configuration page allows you to configure locally

connected devices by assigning a Concert “channel’ to a physical
port on the device (see “Supported USB Devices” on page 3-1).

Note: The ability to configure interfaces must be enabled for you by

the system administrator.

Note: You must be logged in to the server before you can access

this dialog.

1. To access the Interface configuration dialog, click on the
Interfaces icon.

Clear-Com Concert™ Configuration

Q Input

General i |-Select a Device-- |
m AutoConnect Part Channel Status Aetion
Devices

&

Motifications
Cukput

ﬁ L] |--Select a Device-- j

Audio

AutoConnect Port Channel Status Fetion
Server
Interfaces -
Connect all Disconnect &l Save Cancel

Figure 1-18: Interface Configuration Dialog

Note: Input and output devices allow you to bring audio into or out of

Concert through an external device. They are configured
separately in order to provide additional flexibility.

Input Devices

2. InInput area (upper part of the page), select your input device
from the dropdown list. The number of available analog ports
displayed will correspond to the type of device selected.
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Clear-Com Concert™ Configuration fg

Q Input
General th |——Select a Device-- j
--Select & Device—-
L eardMicrosoft Sound Mapper - Input
IDT Audio
IUSE Audio Device
. Fask Track Pro In 1/2
Devices Fast Track Pro In 5/PDIF
Notifications
Oukpuk
ﬁ - |——Select a Device-- j
Audio FAutoConnect Port Channel Status Fotion
Server
Interfaces -
Connect all ] [D|sconnect alll [ Save l [ Cancel

Figurel-19: Device Selection

Note: When you select a device the drop-down list, the capabilities
of that device are automatically retrieved by the Concert client.
Some devices, such as an onboard sound card, may

unexpectedly display two ports. This usually occurs when the
device supports stereo input or output.
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°

General h |Fast Track Pro In 12 ﬂ
m AutoConnect Port Chaninel Status Fction
, ™ 1 --Select a channel--
Devices
--Mo selection--
M 2 Party-Linel

&

Notifications

Input

Party-Linez
Program Feed {input)
Public Address {output)

Cutput

ﬁ = |——SelectaDevice-- j
Audio AutoConnect Port Charninel Status Potion
Server
luteifdees [ Connect all l [Disconnect alll I Save l [ Cancel
Figure 1-20: Input Channel Selection
3. Inthe Channel field, for each input port, select the channel to

Note:

be assigned. The channels listed in the dropdown are those
that are currently associated to your role (as configured by the
system administrator).

If the list is empty, contact the system administrator.

For each input port, use the Auto Connect checkbox to

specify whether the port-channel configuration should be
automatically re-established every time you log in (or the
device is connected to your PC while already logged in).

Output Devices

5.

In the Output area (lower part of the page), select your output
device from the dropdown list. The corresponding number of
ports is displayed.

In the Channel field, for each output port, select the channel to
be assigned. The channels listed in this dropdown are those
that are associated to your role.

For each output port, use the Auto Connect checkbox to
specify whether the port should be automatically reconnected
every time you log in (or the device is connected).
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Note: The Status indicator represents the connection status that

each port-channel configuration has with Concert.

8. Use the Action buttons, on the right side of the page, to
manually connect or disconnect individual channels.

Clear-Com Concert™ Configuration E|
@ Input
General | =l
m AutoConnect Port Channel Status Fetion
Devices n 1 Program Feed ({input) O ™
™ 2 --Select a channel--

&

Notifications
Cukpuk

ﬁ - |Fast Track Pro Ouk 1§2 ﬂ

Audio HAutoConnect Port Channel Status Fetion
@ [ 1 Public Address {output) | E
Connect
Server r z --Select a channel-- |
Interfaces -
l Connect all ] [Dlsconnect all] [ Save l [ Cancel

Figure 1-21: Connecting Channels

Note: A tooltip is displayed when you hover your mouse pointer over

a button (as shown above, for the output Port 1 Connect
button).

Other Controls

Connect All Connects all configured port-channel
configurations (on this client only).

Disconnect All | Disconnects all connected port-channel
configurations (on this client only).

Save Saves changes made in other pages only
(changes in this page are made dynamically).

Cancel Cancels changes made in other pages.
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OPERATION

This chapter covers the use of the Concert system and how to
modify configuration settings.

LOGGING IN

Once the Concert application has been configured, it will display
the user login screen (unless automatic login has been set up).

Before logging in to the network, you will need to have a user
account set up by your Concert system administrator.

- Clear-Com Concert™ Disconnected E@g|
File Yew Config About

I

I Concert

Username | samples

EE s E s
Password |

[T start aukomatically

™ Sign in automatically

Sign in

+ Offline b {4 [1=4

Figure 2-1: Concert Login
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Note:

Enter your assigned Username and Password.

To launch Concert automatically when the computer is started
or sign in automatically, select the appropriate checkbox
(optional).

Click Sign in to log in to the Concert system.

If you have selected the automatic login option, then Concert
will no longer require you to enter your username and
password.

e To display the client version number, click About on the
Concert menu bar.

About Clear-Com Concert™ §|

m- Clear-Com Concert™ 2.5.0.40
-

Copyright© 2009 Yitec Group
Clear-Com Communicakion Systems
v, ClESrCo . Comm

Figure 2-2: Concert About
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CHANGING YOUR PASSWORD

To change your password, you must first log in (either manually or
automatically).

* Clear-Com Concert™ - Emily J... |:||E|E|
File Wiew Seyis® About

E! 8 Eeneral

Devices —_——a|

&J Conts  pgtifications |
. Audio
CO  server

Channels

[

Change Password

Intercom Mode

Ed

Edit Suite New York

Meeting Room

Production Team 1

[ £

e A A W . T

Drag and Drop a Conference or a Conkack
ko establish a call

{3 + fvailable @& i [|H i~

Figure 2-3: Config Menu

1. From the Config menu, choose Change Password. The
Change Password dialog appears:
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Clear-Com Concert™ - Change Password

Current Passwiord; | e

Mew Password | e

Re-enter new Passwiord | F—

ok || cancel |

Figure 2-4: Change Password Dialog

2. Enter your Current Password.

Note: If you do not know your current password, contact your
Concert system administrator.

Enter your New Password.

Re-enter your New Password.

Click OK to complete the change (or Cancel to abandon the
change).

NAVIGATION
TOOLBAR

There are three buttons on the Concert client toolbar (above the
tabs). These provide shortcuts for adding a contact, opening the
configuration dialog, or displaying the Intercom panel:

&

Opens the dialog to add a new contact to a group

&

Opens the client configuration dialog

P

Enables the Intercom mode and opens the Intercom panel
window

2-4
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TABS

You can change the order of the tabs, if required, by dragging a
tab and dropping them in a new position on the tab bar. The new
tab positions will not be saved when you exit the client.

= Clear-Com Concert™ - Emil... |:||E|E|
File Miew Config Help

o0

‘ 4 ﬂ; Contacts = @ Conferences b Inte b

Figure 2-5: Tab Bar

You can also scroll horizontally through the tabs using the arrow
buttons at either end of the tab bar.

DOCKING

Concert allows you automatically align the client window to either
the left or right side of your desktop. If you are in Intercom mode,
then the virtual Intercom panel will also be aligned to the left or
right.

1. To dock your client window choose Docking from the View
menu.

File m Corfig  Help
a! Shaw Histary |
Dacking 3 UnDock

4 5 cContacts @

% Broadcast (2/16)
£ Alex Smirnovy
€2 Florence Gagnon

&8
Errna Martin
Ethan Wilson
Hannah Smith
Jack Brown
Jacoh Lee

Jawar Singh
Lucas Muller
Matia Hernandez

F
Flor Gagn Pty Line Prg Feed

Figure 2-6: Client Window Left-docked

2. Choose Right docking or Left docking (as required). The
client window cannot be dragged once it is docked—the panel
remains free to move.

3. To turn off docking, choose Docking > UnDock from the View
menu.
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OPERATION
PLACING A DIRECT CALL

One method for Concert users to communicate with each other is
to make a “direct call” to a contact. This feature allows you to call
any online contact(s) in your Contact list.

- Clear-Com Concert™ - Emil... |Z||E|[Z|
File Miew Config Help

o006

4 I:_f?:,l:rl:nnl:::mtl:s @ conferences b Char b

%> Broadcast (2/18) S
{3 Alex Smirnoy
% Florence Gagnon
D06
Ernrna Martin
Ethan ‘Wilson
Hannah Smith
Jack Brown
Jacob Lee
Jowar Singh
Lucas Muller
Maria Hernandez

,% Florence Gagnon ...

Calling Florence Gagnon
LTS
13:39:50

Q

9 » Available & |0 18 1=

Figure 2-7: Placing a Call

There are four methods for doing this:

e Click the mouse pointer on the contact and then click the
telephone icon;

e Drag-and-drop the contact into the My Calls area,;

e Double-click on a contact name.
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Click on the Direct Call icon within the chat dialog.

Any of these methods will initiate the call and “ring” the contact’s

Concert station. The call will only be established if the contact
accepts the call, unless Automatic Answer was enabled by your

contact. In this case, the connection will be automatic.

RECEIVING A DIRECT CALL

When you receive a call, the caller is displayed in the My Calls

area. You have the option of accepting or rejecting the call, unless
automatic answer was enabled by your contact. In this case, the
connection will be automatic.

2 Clear-Com Concert™ - Jowar ... |'-_

File Miew Config Help

o0

=

& Contacts . Conferences

3 Broadcast (2/16)
{3 alex Smirnoy
% Emily Johnson

Ernrna Markin
Ethan Wilson
Flarence Gagnon
Hannah Smith
Jack Broven
Jacob Lee

Lucas Muller
Maria Hernandez

|

£

{% Emdy Johnzoan ... f% Florence Gagnon ...

Florence Gagnon is inviting you
on a private conference
M

124105

SR

£ « Available

-

L AT

Figure 2-8: Incoming Direct Call
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In the example above, user “Florence Gagnon” is calling user
“Emily Johnson”. As shown in Figure 2-7, there is a notification of
this action in the My Calls area and a prompt to either accept or
reject the call.

If Emily clicks on the amber “Accept” G icon, she will accept the
call initiated by Florence. Both users will then be able to converse
with each other through their configured audio devices.

However, if Emily clicks on the “Cancel” Q icon to refuse the call,
Florence will be notified of the refusal.

@ Florence Gagnon ¥ X
(1 Talking and Listening 000003 l:] m
2 Florence Gagnon of t!:.l
& » Available @ (3 i~

Figure 2-9: Direct Call in Progress

& Emily Johnson ... ¥ X
Emily Johnson has rejected the call
14406138

£ « Available . ‘b Ht!'J i~

Figure 2-10: Direct Call Rejected

Florence would then need to click on the “checkmark” Q icon to
acknowledge and clear the response from the remote user.

If left unanswered, the ring will terminate after one minute
resulting with the following message displayed to the caller
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& Alex Smirnoy ...

Al
x

Alex smirnoy did not answer your call
1312558

£ + Available [ 228 .' e
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SETTING UP A VOICE CONFERENCE

1. Click on the Conferences tab. The Conferences page lists all
of the authorized conferences for your assigned role:

- Clear-Com Concert™ - Emily J... |Z||E|r5__(|
File Wiew Config Help

o>® 06

ﬂj Contacks . Conferences
. Conference 1

Conference 2

>

Corpx Weekly

Edit Suite London

Edit Suite New York

Meeting Room

| £

[ U [ R, ——

Drag and Drop a Conference or a Conkack
ko establish a call

3 - fvailable & i 14 i~

Figure 2-11: Conference Setup

2. Select one of the available conferences from the list. When
you do this, you will see a set of icons representing your
access permissions for the conference.

In Figure 2-12, below, Emily has both Talk and Listen privileges to
“Conference 2.

3. Tojoin a conference with Talk/Listen privileges, click on the
amber microphone icon.
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4. To join a conference with Listen-only privileges, click on the
green speaker icon.

5. Tojoin a conference with Talk-only privileges, click on the red
speaker icon.

* Clear-Com Concert™ - Emily J... |:||§|r5__(|
File Wiew Config Help

PR AP,

& Contacts . Conferences

[

Conference 1

Conference 2

DO D

Corpx Weekly
Edit Suite London
Edit Suite New York

Meeting Room

| £

[ RPN [ TR, ——

Drag and Drop a Conference or a Conkact
ko establish a call

3 + dvailable . i b Ht!i i=

Figure 2-12: Join a Conference

Once you have joined a conference, the conference icons will
change to show the new options that are available. The indicator
beside the conference name will change from blue (Not active) to
either amber (Talk/Listen), green (Listen), or red (Talk-only).
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Status and presence information for the channel appear in the My
Calls area along with any other Concert users who have joined the
conference.

- Clear-Com Concert™ - Emil... E|E|[z|
File Wiew Config Help

o® 06

4 | @ Conferences | |- Interfaces ‘QHis 4

L
. Conference 1 T

. Conference 2

. Meeting Room

. Production Team 1

Production Team 2

.Ennference 1 ¥ X

Listening only 000750 m
' Party-Linel 4 t!:.l
£ lowar Singh =f
2 Florence Gagnon of
2 - Available . ib Ht!ﬂ i=

Figure 2-13: Conference Status and Presence

Upon joining a conference, a timestamp will appear in the user
status area of My Calls, indicating how long you have been in the
conference.

Note: The above example shows a conference that includes a
channel called “Party-Line1”. For more information, see
“Channels” on page 2-14.
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Restrictions on Joining Conferences

You may join any public conference that your assigned role allows
by dragging-and-dropping one of the “join/leave” icons from the
conference into the My Calls area.

Where two or more users are linked by direct calls made through
the Contacts list, this is described as a private conference. Private
conferences are not visible to other users—other users can only
join a private conference if they are invited by a participant of that
conference.

The following options are available:

£3 | Leave the conference at any time

&) | Listen-only

) | Talk/Listen

@@ | Talk-only

The always visible My Calls area, in the lower part of the window,
displays status and presence information about all joined
conferences and calls.
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Channels

A Concert channel represents a potential connection with a
physical port on an audio device.

Calling a channel is similar to calling a personal contact (as
described earlier), except that you connect through the Channels
tab. Such calls are answered immediately (no ringing).

If the system administrator has granted you access to one or more
channels, then the Channels tab will be visible in your Concert
window.

- Clear-Com Concert™ - Emil... |Z||E|[g|
File Wiew Config Help

o® 06

4 | B> Channels @Histnry 3
' Party-Linel

-

' Party-Line2
' Program Feed (input)

Pubic Address (output)

Drag and Drop a Conference ar a Conkack

ko establish a call

£ « Available . b Htlﬂ i=

Figure 2-14: Channels Tab

Note: If the channel is also associated to your user profile, then you
will have the ability to modify its permissions (Talk/Listen,
Listen-only) through the Channels tab.
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This tab displays all of the channels that have been configured for
your partition (not just the ones associated to your profile). To the
left of each channel is an icon that identifies its presence status:

D Channel is online

Channel is offline

' Channel is listening

' Channel is talking

Channel is talking and listening

When you join a conference that has an associated channel, the
channel is connected automatically.
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File Wiew Config Help
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4 )} Channels @Histﬂry »
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DO
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Program Feed
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Ports  Channels Client

o
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[ ]
[]

Device Concert
Ports  Channels

N

. ® 1

IP Network

o N O U WN R
¢
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“— 5 © ©® N O O~ WN

uUsSB
Interface

2- to 4-wire @

Interface

Party-Line

Figure 2-15: Sample Configuration

In this example, Users “A” and “B” can communicate over IP using
the direct call feature. Depending on their roles, they could also
join a pre-defined conference (see below).

A USB audio device has been connected to one of the client
computers, and User “B” has assigned Channel 1 (Party-Line) to
an 1/O port (Port 1) on the device.

User “A” has Talk/Listen privileges to the Party-Line channel. By
clicking on the amber Talk/Listen icon, this user can create a bi-
directional conference with the Party-Line users.

An M-Audio PCI interface has been connected to the Concert
server. The administrator has assigned various channels to
physical ports on the device. Channel 5 (Program Feed) has been
assigned to an input port (Port 4). If this channel is also
associated to the above-mentioned conference, then all users will
hear the Program Feed through the conference.
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MANAGING CONTACTS

The Contacts page displays a configurable list of Concert users,
which are sub-divided into contact groups. As discussed earlier,
you can use your contact list for making direct calls.

By default, every user has a contact group containing all the users

within his partition (the contact group name is the same as the

partition name). If a contact’s name is displayed in bold, then the
contact is online. Offline contacts are always displayed after the
online contacts.

1. Todisplay your contacts, double-click on the default contact

group. In this example, “Broadcast” is the contact group.

_* Clear-Com Concert™ - Emil...

H=1/3
File Miew Config Help

o0

4 {__% Contacts = @ Conferences b Inte »
* Broadcast {0/16)

Alex Smirnoy
Ernirma Martin
Ethan wWilson
Florence Gagnon
Hannah Smith
Jack Brown
Jacob Lee

Jowar Singh
Lucas Muller
Maria Hernandez
Michael Tanaka

Drag and Drop a Conference or a Conkack
ko eskablish a call

& - available

@ 5181 i~

Figure 2-16: Managing Contacts
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Note: The presence status of each contact is indicated by an icon to
the left of the contact name (see “Determining Contact
Presence”on page 2-19).

EOX

 Clear-Com Concert™ - Emil...

File Miew Config Help

o006

4 I:_f?:,l:rl:nnl:::mtl:s @ conferences B Inte b

39 Broadcast (1/16) S
Ales Smirnoy
Ernrna Martin
Ethan ‘Wilson
i Florence Gagnon
D06
Hannah Smith
Jack Brown
Jacob Lee
Jowar Singh
Lucas Muller
Maria Hernandez

Drag and Drop a Conference or a Conkack

ko eskablish a call

9 » Available & |0 18 1=

Figure 2-17: Contact Call Options

2. Todisplay the connection options for a contact, click on the
contact name:

£ | Placing a direct call

=) | Initiating a chat

(% | Inviting the contact to a conference

Note: A tooltip is displayed when you hover your mouse pointer over
an icon.
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- Clear-Com Concert™ - Emil... |Z||E|[Z|
File Miew Config Help

o006

4 I:_%l:rl:nnl:::mtl:s @ conferences B Inte b

» Broadcast {1/16) S
Ales Smirnoy F
Ernrna Martin
Ethan ‘Wilson
Florence Gap=~=

O @ C O Place a direct call

Hannah Smith @ Start Chat
Jack Brown

Jacob Lee l:::l Invite to conference)call
Jowar Singh

Lucas Muller @ Chat Archives
Maria Hernang
= & Remove From Contacks

Maove ko another group

Drag and Drop a Conference or a Conkack
ko eskablish a call

£ « fvailable & |0 [0 I

Figure 2-18: Contacts

3. To display expanded options (e.g., remove contacts from the
contact group, view chat archives), right-click on the contact

name.
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DETERMINING CONTACT PRESENCE

The Presence feature provides real-time online status information
for all users within the system. On the Contacts page, there is a
presence status indicator for every contact in the list.

However, other status types exist. You can manually adjust your
own status by clicking on the “availability” icon in the lower left
corner of the application window. This will display the following
possible statuses for a user:

Offline

Online

Away

=N B

Be Right Back

2

Away for Lunch

Not Available

U

Do Not Disturb

Invisible

When you select one of these other status types, it will be
displayed against your name in any contacts pages that contain it.

Note: If you sign out or exit Concert, your selection will be saved.

The main functions of the application are available through the
Windows taskbar icon: You can call a contact, join a conference,
or change status through the taskbar (see “Taskbar Navigation”
on page 2-27).
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CREATING A CONTACT GROUP

In order to more easily manage your contacts, Concert allows you

to create contact groups. The contact group that you create will

appear at the bottom of your contact list.

- Clear-Com Concert™ - Emil... |Z||E|[z|
Wiew Config  Help
Sigr Sk

Manage Contacts add a Contact
Save Intercom Panel Layouk

a Group

Quit

Ernma Martin
Ethan \Wilson
Florence Gagnon
Hannah Smith
Jack Brown
Jacob Lee

Jowar Singh
Lucas Muller
Maria Hernandez

Drag and Drop a Conference or a Contack

ko establish a cal

£ ~ fvailable & (i [ 1~

Figure 2-19: Create Contact Group

1. To add a contact group, follow the menu path: File > Manage
Contacts > Create a Group.
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A dialog prompts you for the name of the new contact group:

Create a Group ['5_<|

Garoup Mame:

| [enter group name]|

K Cancel

Figure 2-20: New Contact Group

2. Enter the new name and then click OK to create the group and
add it to the list of contact groups (or Cancel to abandon the
creation of a new group).

- Clear-Com Concert™ - Emil... |: E'E'

File Wiew Config Help

o® 06

1 &Euntacts @ conferences b Inter b

Jack Brown -
Jacob Lee
Jowar Singh
Lucas Muller
Maria Hernandez
Michael Tanaka
Miguel Garcia
Clivia Tavlor
Ruby Jones
Sophia Rossi
Thomas Wong
» Production {0,/0)

|

Drag and Drop a Conference or a Conkact
ko eskablish a call

& « available & b I i<

Figure 2-21: New Contact Group Added
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ADDING CONTACTS TO A GROUP

1. To add a contact to a contact group, follow the menu path:
File > Manage Contacts > Add a Contact (or right-click on
the contact group).

- Clear-Com Concert™ - Emil... |Z||E|[z|
File WYiew Config Help

o>® 06

1 &Euntacts @ Conferences b Inker b

Jack Browin s

Jacob Lee

Jowar Singh

Lucas Muller

Maria Hernandez

Michael Tanaka

Miguel Garcia

Olivia Tavylor

Fuby Jones

Sophia Rossi

Thomas Wong
“* Production {0/0})

Delete emply Group,..,

&dd a Contact...

Drag and Drop a Conference or a Contack
ko establish a call

& + fvailable @ | i

Figure 2-22: Add New Contact

2. Select the group to which the new contact will be added.
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The Add Contact dialog appears:

Add Contact

Group |Pru:u:|uu:ti|:|n ﬂ

User | Sophia Rossi

| add | | cancel |

Figure 2-23: Adding a New Contact

3. Enter either the unique username for the contact or the
contact’s login ID.

Note: A user must be removed from any other contact group before
being added to a new group.

Note: You can also drag-and-drop contacts from one group to
another (or right-click on the contact and choose Move to
another group).

4. Click Add to add the user to the contact group (or Cancel to
abandon the action).
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The contact is automatically removed from the original group:

- Clear-Com Concert™ - Emil... |:||E|E|

File Miew Config Help

PP

1 &Euntacts @ conferences b Inter b

Jack Brown
Jacob Lee

Jowar Singh
Lucas Muller
Maria Hernandez
Michael Tanaka
Miguel Garcia
Clivia Tavlar
Ruby Jones
Thomas Wong

Sophia Rossi

Drag and Drop a Conference or a Conkack
ko establish a call

3 - Available

)

||

& 5141 i

Figure 2-24: Contacts
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Removing Empty Groups

1. Toremove empty contact groups from the system, right-click
on the group name and choose Delete Empty Group. You will
be asked to confirm the action.

o006

- Clear-Com Concert™ - Emil... |Z||E|[X|
File Miew Config Help

Jack Brown
Jacob Lee
Jowear Singh
Lucas Muller

Michael Tanaka
Miguel Garcia
Clivia Tavlor
Fuby Jones
Sophia Rossi
Thiomas Wiong
* Production {0,/0)

£ « Available

4 &Euntacts @ cConferences B Inter b

Maria Hernandez

Y

Delete empky Group...

Add a Cantack, ..

Drag and Drop a Conference or a Conkack
ko eskablish a call

L A EC]

Figure 2-25: Empty Group Deletion

2. Click OK to remove the empty contact group (or Cancel to

abandon the action).

Note: If the contact group is not empty, the group deletion option will

not be available.
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Auto-add Functionality

The auto-add feature allows you to easily add a user to your
contact list upon receiving a chat request. If you receive a call
from a user who is not already in your contact list, the following
dialog appears:

Chat from new Contact: EmmaM E'

Message from new Contack
Eraral: @@ __ Eyping_ @
Do wou wank to add Emmat ko wour conkacks Lisk 7

Cancel

Figure 2-26: Auto-add a New Contact

1. To add the caller to the current contact group, click OK (or
Cancel to disregard the request).

TASKBAR NAVIGATION

The main functions of the application are available through the

Concert Online & icon in the Windows taskbar, which allows you
to call a contact, join a conference, or change your status.

1. Todisplay the menu options, right-click on the Online icon.

2 Crline

5 fway |

{E Be Right Back D Cpen Clear-Com Concert™

i Away For lunch !‘, Qpen Clear-Com Concert™ Intercom Panel

% Mot Available & Contacts R

& Do nat disturb

@ Join Room »

iw) Change Status

= sign out

_ €9 Quit Clear-Com Concert™ m

Figure 2-27: Taskbar Navigation

Invisible
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IID Open Clear-Com Concert™
. Meeting Foom 4

E Open Clear-Com Concert™ Intercom Panel
. Production Team 1 L

33 Contacts 4
. Production Team 2 8  10in Room

| €% Change Status *
= sior oue

_ €23 Quit Clear-Com Concert™ m

Figure 2-28: Taskbar Navigation 2

During a status change event, contact status change notifications
will appear just above the taskbar. These notifications are meant
to provide an awareness of contact presence. Examples of such
notifications are shown below. Notice in the Online notification that
you have the option of either initiating a direct call or chatting with
the contact.

€ Concert (%)

Flarence Gagnon
i=anilne

Q O

Figure 2-29: Contact is Online

€ Concert (%)

Flarence Gagnon
iz away

Q@ O

Figure 2-30: Contact is Away
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VIEWING HISTORY

The History page provides a chronological history of all
conference join/leave actions as well as all direct calls made and
received.

1. Todisplay join/leave history, follow the menu path: View >
Show History. The History tab appears in the Concert
window:

- Clear-Com Concert™ - Emil... |Z||E|rz|
File Miew Config Help

o006

4} Interfaces €5 History 3

. 2009-12-16 13:46:06 Conference 2
. 2009-12-16 13:45:17 Conference 2
. 2009-12-16 12127122 Meeting Room
. 2009-12-16 12124120 Meeting Room
. 2009-12-16 1212347 Meeting Room
. 2009-12-16 12123126 Meeting Room
. 2009-12-16 12:12:01 Conference 2
. 2009-12-16 12:11:01 Meeting Room
. 2009-12-16 12:10:52 Conference 2
. 2009-12-16 11:51:38 Meeting Room

. Meeting Room
2009-12-16 11:50:29 Conference Joined

|

[ES

Drag and Drop a Conference or a Conkack

ko eskablish a call

9 » Available & |0 18 1=

Figure 2-31: History of Conferences and Direct Calls

2. To clear history, go to the Config menu and choose General
> Clear Event History.
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STARTING A CHAT

To initiate a chat with another contact:
1. Select the Contacts tab.

2. Select a contact from the list.

3. Click on the @ icon.

The chat window will open with a title bar specifying the name of
the contact with whom you are chatting. A timestamp will be
displayed next to each message sent or received.

& Emma Martin - Clear-Com Concert™ Chat [’._||E|rz|
€2 Ernma Martin iz Aovailable

Emily Johnson:

Hi Ernma

»EOS

Send

Figure 2-32: Start a Chat

Located at the bottom left of the chat window are various
configuration controls:

oy

Keep the chat window always on top of other windows

®

Set the window transparency level

O

Place a direct call with the user

=

Display past conversations with this user

Each click will display the last five messages.

Note: Chat archiving must be enabled within the General
configuration page for this feature.
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Broadcasting a Message

This feature allows you to broadcast a chat message to all of the
contacts in a group.

* Clear-Com Concert™ - Emil... E@

File Wiew Config Help

o® 06

1 &Euntacts @ conferences b Inter b

A

Alex i
Ernme
Ethar
Florence Gagnon
Hannah Smith
Jack Brown
Jacob Lee

Jowar Singh
Lucas Muller
Maria Hernandez
Michael Tanaka

Send Chat msg to Group. ..
Add a Contact...

| %

Drag and Drop a Conference ar a Conkack
ko establish a call

£ « Available . b Htlﬂ i=

Figure 2-33: Broadcast a Message

1. To broadcast a chat message, right-click on the group name.
2. Select the option Send Chat Msg to Group...

All of the contacts in the group will receive your chat message.
The reply message will only be sent to the initiator of the group
message.
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STATUS BAR: VOLUME CONTROL

The volume controls are located in the bottom right corner of the
Concert window. The following icons are available:

Audio Device Switch: Toggles between primary and secondary
audio devices

dib

f# | Microphone Mixer: Displays controls for the audio input device

i< | Player Mixer: Displays controls for output audio device

AUDIO DEVICE SWITCH

The audio device can be changed to primary or secondary directly
from the status bar.

£ + fvailsble '. dih HK!J' =

Figure 2-34: Audio Device Selector
1. To switch to the Secondary Audio Device, click on the &b

icon. The icon will be updated to the secondary audio device
&/ jcon.

£  available . &b HL!J i=

Figure 2-35: Secondary Device Selected

Click again to toggle back to the primary audio device.

For more options, right-click on the icon to display the device
selector context menu.

£ ~ available . Pt T
‘b

|| Switch to Secondary Device

H show Audio Device Manager

Figure 2-36: Audio Device Selector Options

4. To display the device in use, hover your mouse pointer over
the icon (see below).
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£3 » Available & /[ =

Using Primary Device

Player: Crystal WD Audio

Recorder: Crystal WM Audio

Left Click to switch to Secondary Device

Figure 2-37: Audio Device

Microphone Mixer

To display the controls for the audio input device, click on the £
icon (or right-click on the icon and choose Show the Microphone
Mixer).

3 + Available @ (i

= Mute the Microphone

(2

[t show the Microphone Mixer

| show Audio Device Manager

Figure 2-38: Input Volume Controls

Microphone mute/un-mute options are also available within this
context menu as well as the ability to open the Device Manager
dialog. This is the same as choosing Devices from the Config
menu.

Player Mixer

£ + Available . ik Hl‘b =

[ | shaow the Player Mixer

t show Audio Device Manager

To display the controls for the output audio device, click on the

Player Mixer I icon (or right-click on the icon and choose Show
the Player Mixer).
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The following dialog appears:

Cpkions  Help

Speaker Mizrophone
B alance: Balance:
Yalurne: Yalure:

L
L

[ Mute all [ Mute
JSE Audio Device

Figure 2-39: Volume Controls

Note: The volume control panel may show different controls
depending on the available hardware.

NETWORK CONNECTION QUALITY

When you are logged in to the server, an @ icon in the status bar:
represents the connection quality.

3 - Available .' ' Ht!'J i=

Conneckion Qualicy: Excellent
Recv=0
Recovered=0,Lask=0,

Drops Too late=0,
Crerrun=0,Reduction=0

Figure 2-40: Connection Quality

There are three levels, with a different color associated to each:

@ | Good: No packets lost or recovered

& Medium: Some packets recovered

@ | Bad: Some packets lost
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To view these statistics (averaged over the last 10 seconds),
hover the mouse over the connection status icon.

If your network connection quality is frequently “medium” or “bad”,
you may encounter poor audio quality. You may be able to fix the
audio quality problem by changing your network settings (refer to
“Audio Options” on page 1-15).
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INTERCOM MODE

Concert v2.5.0 includes a virtual Intercom panel. This feature
allows you to communicate with both Concert and Eclipse users
simultaneously through a single interface. This virtual Intercom
panel operates similar to the way an Eclipse V-Series pushbutton
panel operates.

By default, the Intercom panel is not initially displayed. To switch
to Intercom mode, open the Config menu and select Intercom
Mode.

- Clear-Com Concert™ - Emil... |Z||E|[Z|

File  Wigws Ralgils]

i! @ General

Devices
h L%E“' Motifications b Char b
Audio
Alex  Server
Erin|  Channels

Eth:
Flar
Han
Jack
Jacob Lee

Jowar Singh
Lucas Muller
Maria Hernandez
Michael Tanaka

hange Password

Intercom Mode

Drag and Drop a Conference or a Conkack

ko eskablish a call

£ « fvailable & |0 [0 I

Figure 2-41: Displaying the Virtual Intercom Panel
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In Intercom mode, the Concert client will continue to be displayed
along with the virtual Intercom panel.

If an Eclipse connection has been configured for you by the
system administrator, Concert will attempt to establish that
connection (see “Operating Intercom with Eclipse” on page 2-43).

Page Control Tabs Key Qutput Level

P> Clear-Com Concert™ | .tercom Panet Emily Johnsen
INOTTERMN  Pags-2  Pags-3  Page-d | Eclipse
Connection

Microphone
Mute

Configuration

Open Concert
Window

Figure 2-42: Concert Intercom Panel Layout

INTERCOM PANEL CONTROLS

The controls on the right side of the panel provide the basic
facilities for the Concert Intercom panel.

Output Level: To change the audio level of the preferred audio
output device, use your mouse to drag the output level slider up or
down.

Microphone Mute: Click this button to toggle the audio input
device on or off. When the microphone is muted, the button
displays a red “X”.

Configuration: Click this button to open the configuration facility
used by the Concert client (see “User Configuration Options” on
page 1-11).

Concert Button: Click this button to switch back to the Concert
client.

Page Tabs: The Intercom panel supports four pages, each
comprising 24 user-defined keys. To view a different page, click
on the appropriate page tab.

INTERCOM PANEL CONFIGURATION

To configure the Intercom panel with Concert users, conferences,
or channels, drag-and-drop the appropriate items from either your
Contact list, Conferences tab, or Channels tab onto available keys
on the panel.

Once these keys appear on the panel, you can use them to call
other Concert or Eclipse users, join a conference, or connect to a
channel.
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Concert User
Not Logged On

P Clear-Com Concert™ Intercom Panel - Emily Johnson

TR Foodre Pags-3  Page-d |

Alex Smir

Flor Gagn

Concert User Conference
Logged On Key

Figure 2-43: Concert Intercom Panel with Users

The text displayed on each of the configured keys is the “key
name” specified by the system administrator during the creation of
that user, conference, or channel.

USING THE INTERCOM PANEL

If you have both the client and Intercom panel open at the same
time, a call from another Concert user will be displayed on both
panels.

User Keys

The user keys on the Intercom panel appear initially as:

Blank, if no user has been assigned to the key.

Grey, if the user is either not online or the user’s

R status has been set to “Invisible”.

e Intercom user: Split green (Listen) and red (Talk),
Flor Gaar if the user is available to call in either mode.
Non-Intercom user: Amber, if the user is
available to call in Talk/Listen mode.

D
e
(=
J

Note: If you place your mouse pointer on a user key, the user status
will be displayed (e.g., Available, Offline, or Online). No status
is displayed for conference keys.
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Conference Keys

The conference keys on the Intercom panel appear initially as:

Split green (Listen) and amber (Talk/Listen),
indicating that you can join the conference in

either mode.

Solid green, indicating that you can join the
conference in Listen-only mode.

Confz

Solid red, indicating that you can join the
conference in Talk-only mode.

Channel Keys

The channel keys on the Intercom panel appear initially as:
¥ ) Grey, indicating that the port/channel is offline
R (see “Interface Options” on page 1-22).
" Split green (Listen-only) and red (Talk-only),

== indicating that you can join the conference in
either mode.

Placing a Direct Call

To place a direct call to a contact, click once on the corresponding
contact key. If the contact is a non-Intercom user, this will initiate
the call and ring their Concert client.

To place a Talk/Listen call to a non-Intercom-
enabled user, click on the amber contact key for

the user.

- To place a call to an Intercom-enabled user, click
Flar Gagn on the appropriate portion of the contact key:
e Listen-only: Click on the green portion of

the key. It will light up to indicate that the
call has been placed.

e Talk-only: Click on the red portion of the
key. It will light up to indicate that the call
has been placed.

e Talk and Listen: Click on one portion and
then the other. Both will light up.
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When you connect to an Intercom-enabled user,
the contact key will change to three quarters
amber (Talk/Listen) and one quarter red with an
“X” on it. You can toggle to Listen-only mode by
clicking on the amber portion. The key will
change to green (see below).

To toggle back to Listen-only mode, click on the

i green portion of the key. To end the call, click on
the red “X”. The key will change to its original
state (full amber).

Flar 5agn

Receiving a Direct Call

When you are in Intercom mode, your Intercom panel will
automatically accept any incoming calls from other Intercom
panels. For each call accepted, a call item (temporary key) is
created in the My Calls area of the panel. Multiple received calls
will stack down in this area.

In the case of a call from a non-Intercom user (Talk/Listen), the
temporary key displays three quarters amber and one quarter red
with an “X” on it.

P2 Clear-Com Concert™ Intercom Panel - Emily Johnson E]|E

My Calls
Flor Gagn a

Figure 2-44: Incoming Call on the Intercom Panel

| You can toggle to Listen-only mode by clicking
Flor agn on amber portion of the call item. The key will
change to green (see below).

To toggle back to Listen-only mode, click on the
green portion of the call item. To end the call,
click on the red “X”. The key will be cleared from

the My Calls area, and any user key will return to
its original state.
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Intercom to Intercom

To place a direct call to from your Intercom panel to another
Intercom contact, click once on the appropriate portion of the
contact key (Talk and/or Listen). There is no ringing, and the audio
connection is immediate.

" To connect with the other panel in Listen-only
mode, click on the green portion of the key. It will
light up to indicate that the connection has been
established. To connect with the other panel in
Talk-only mode, click on the red portion of the
key. You can be connected in both modes

simultaneously.

To cancel the call, click on the caller key so that it
returns to its original color.

In the case of a Talk-only call from another
Intercom user, the receiving panel will display a
red key with a flashing border in the My Calls
area.

To accept the incoming talk call, click on the My
Calls item. The key borders will stop flashing and
the key color will change to dark red.

1@ Any time another Intercom user is listening
through your panel, the Listeners icon appears
above the My Calls area, and the listener count
increases by one.

Incoming Flashing Key
Talk Call Border

X Clear-Com Concert™ Intercom Panel - Emily Johnson

BTN Pags-2  Page-3  Page-4

Alez Smir

Flashing Portion of

User Key Conference Key

Figure 2-45: Incoming Talk on Intercom Panel

Note: The caller key will remain in the My Calls area until you
remove it.
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P Clpar-Com Concert™ Intercom Panel - Emily Johnson

Alez Smir

Flar Gagn

Figure 2-46: Removing Call Button

To remove a caller key, right-click on the key to display the
Remove this button prompt and then click on it.

Conference Calls

Conference keys are initially divided into green and amber
portions.

1. Tojoin a conference in Talk/Listen mode, click on the amber
portion of the key. The conference button will change to
display three quarters amber and one quarter red with an “X”
on it (see below).

2. Tojoin the conference in Listen-only mode, click on the green
portion. Again the key will change to display three quarters
green and one quarter red with an “X” on it.

3. To exit the conference, click on the red part of the button.

To switch between Talk/Listen and Listen-only mode, click on
the amber or green section of the button.

Click om amber Click on red "x"
section for Talk/Listen fio exit
conference confarence

Click on green Click on amber
to change to to change fo
Talk/Listen Listen-only

lick on red "X"
fo exit
confarence

Click on gree
section far Listen-only
conference

Figure 2-47: Using Conference Keys
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Channels

You will recall that a Concert channel represents a potential
connection with a physical port on an audio device. You can drag-
and-drop a channel from the Concert client onto a key in the
Intercom panel. This feature allows you to monitor the status and
control the permissions for any channels that you add to the
panel.

Channel keys are identified by a “channel” - icon in the top left
corner of the key. This icon indicates the connection status of the
channel. Channel keys appear as split green (Listen-only) and red
(Talk-only) when online. Otherwise, they are grey.

P> Clear-Com Concert™ Intercom Panel - Emily Johnson

Partylinez

" Partylinel " Pram Feed ~ Public adr

Figure 2-48: Channel Keys

Either portion of a channel key (or both) can be active or inactive,
depending on the configuration of the channel (see “Interface
Options” on page 1-22).

w To open a connection to a channel, click on the
appropriate portion of the channel key. It will light
up to indicate that the connection has been
established. To close the connection, click again
on the same portion of the channel key.

Prg Feed
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Operating Intercom with Eclipse

Eclipse keys are configured through the Eclipse Configuration
System (ECS), similar to a hardware panel. Eclipse keys
configured by ECS are automatically displayed on the panel when
it is launched (i.e., Intercom mode).

Listen Party line Listen Number of Eclipse
Page tabs key Key active listens active connection

Amanda Hug Amanda Hug

Open
Concert
window

Volume

Talk/Listen Clear Reply  Reply stack
key key answerback key scroll keys
stack

Figure 2-49: Intercom Panel Connected to Eclipse

Eclipse keys in the Concert Intercom panel behave as hardware
pushbuttons. The keys can only act as Talk, Listen, or Talk/Listen
keys depending on the function assigned to them in ECS.

Push-to-talk (PTT)

The keys normally default to latching unless the non-latching
option is selected in ECS under Global Settings (Latch Disable set
to “True”). In this case, if the key is clicked normally, it will latch. If
it is held momentarily, it will not latch (PTT), and the connection
will terminate as soon as the key is released.
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Page tabs

ADJUSTING AUDIO LEVEL

Eclipse keys include an audio level bar at the bottom of the key to
indicate the current level setting for the audio.

1. To allow the audio level to be adjusted, right-click on the key.

Listen Party line Listen Number of Eclipse
key Key active listens active connection

Mic on/off
Configure
Open
Concert
A < window
\ Volume
Talk Talk/Listen Clear Reply  Reply stack
key key answerback key scroll keys

stack

Figure 2-50: Audio Level Adjustment

Click to decrease Level Click to increase
audio level indicator audio level

Figure 2-51: Eclipse Panel Key

2. Toincrease or decrease the audio level setting, click on the
“+” and “-” symbols in the bar.

If no activity is detected after five seconds, the level is set and the
key reverts to its normal appearance. When a key is inactive (no
talk or listen connection established), the key will appear dim red
or green depending on whether it has been configured in ECS as
a Talk (red) or Listen (green) route or a Talk and Listen (amber)
route.

¢ When you click on a key to establish a connection, the
illumination will change to bright red or green.

e When you click on the key again to cancel the connection,
it will once again appear dim.
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Reply Key

An incoming call will be signaled by a flashing red Reply key (in
the My Calls area) with the incoming source label shown inside
the key.

1. To pick up the call, click on the Reply key.

If the client receives multiple incoming calls, they will be stacked

inside the Reply key.

2. Use the scrolling arrows (to the right of the Reply key) to
switch between callers.

3. Use the Clear button (red “X”) to delete all incoming calls from
the Reply key stack.

Note: After a pre-determined period of time, a timeout occurs, which
removes the Reply key.
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SUPPORTED USB
DEVICES

This section describes the USB audio devices that are currently
supported by Concert:

e M-Audio Fast Track Pro ©
e M-Audio Fast Track Ultra ©

Note: If you connect a second M-Audio © device to a USB port (after
disconnecting the first one), it will not be recognized. To avoid
this, use different ports if you are using more than one type of
M-Audio © device.

Note: You will be prompted to install the M-Audio © driver each time
you connect an M-Audio © device to a new USB port.

Note: Connecting USB 4-wire devices to any type of external USB
hub or port replicator is not supported by Concert.
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vi-AUDILY

TRACK PRO

2 , “°"°l‘\

Mlc/lnst

M-AUDIO - FAST TRACK PRO © (FRONT)

Clip M Stereo

| Inst Signal

utput
= Line MIDI In

Feature

Description

Use “In” position for line level
inputs.

Instrument/Line Selector Button: Selects the input
level of the front panel 14-inch inputs (does not affect
XLR input level):
e “In” position: Accepts line level inputs.
e  “Out” position: Inputs accept instrument level
signal.

Microphone/instrument Inputs: Combo connectors
XLR or 1/4-inch TS for powered microphone or
instrument level inputs.

Input Gain Level Knob: Controls input level of
associated Mic/Inst input (2). Variable gain range is
>40dB.

Stereo/Mono Button: Toggles the direct input
monitoring between stereo and mono operation.

position (PB).

Adjust knob to “full-clockwise”

Input/Playback Mix Level Knob: Controls the audio
mix sent to the line outputs, fading between the input
signals and the output signal from any audio
application software:
e Clockwise (PB): Only output signal from DAW
software is heard at line outputs.
e Counter-clockwise (IN): Only input signals are
heard at line outputs.

3-2
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Use “Out” position (A) to select
outputs ports 1 & 2.

DO NOT use “Off” (full counter-
clockwise) position—neutral
position is recommended.

Feature

Description

A/B Monitor Selector Button: Selects output source
sent to Level knob (8):
e “Out” position (A): Main line output signal is sent
to headphone outputs.
e “In” position (B): Signal assigned to S/PDIF
output is sent to headphone outputs (not
supported by Concert).

Headphone Output Level Knob: Controls output
level to Headphone output (10). Independent of main
Output Level knob (9).

Pad Button:
o “In” position: 20dB pad is inserted into input
circuit.

Output Level Knob: Controls signal level at line
outputs—independent from the Level knob (8).

10

Headphone Output: 14-inch stereo TRS headphone
jack. Output level is controlled by Level knob (8).
Source is selected by A/B button (7).
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M-AUDIO -

FAST TRACK PRO © (BACK)

On
S/PDIF
n

Feature Description

Power Button: Press to power on. Unit must be

11 |connected to host computer's USB bus or optional
external power supply.

12 Power Supply Connector: Connect optional 9V DC
500mA power supply when using as stand-alone unit.

13 MIDI Output: Not supported by Concert.

14  |MIDI Input: Not supported by Concert.
Phantom Power Switch: Slide to “On” position to

15 |send 48V power to front-panel XLR inputs (for use
with powered microphones).
Unbalanced Outputs 1 and 2: Unbalanced outputs

16 |on RCA connectors. Mirrors signal to TRS Outputs 1
and 2 (17).
Balanced Outputs 1 and 2: Balanced 14-inch TRS

17  |jacks. Output signal is controlled by front-panel Output
Level (9) and Input/Playback Mix Level (6).

18 Cable Lock Port: Accepts security cable to protect
device from theft.

19 USB Input: Connect standard USB cable to this port
from host computer.

20 |S/PDIF Output: Not supported by Concert.
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Feature Description

21 |S/PDIF Input: Not supported by Concert.

Unbalanced Outputs 3 and 4: Unbalanced outputs
22 |on RCA connectors. Mirrors signal from S/PDIF output
(20) (not supported by Concert).

23 Inserts 1 and 2: Not supported by Concert.

M-AUDIO - FAST TRACK ULTRA ©
(FRONT)

Feature Description

Combo Connectors: XLR or 1/4-inch TS for powered
1 microphone or instrument level inputs (not used with

Concert).
N _ XLR Connectors: for powered microphone or
Always use “In” position (for line 2 . . .
. instrument level inputs (not used with Concert).
level inputs).

Front/Rear Switches: Select between the front XLR
3 inputs and rear panel line inputs. Press to select rear
inputs.

Mic/Instrument Gain/Pad 1-4: Adjust input gain for
4 Ports 1-4. Pull knobs out to engage a 20 dB pad on
input (not used with Concert).

5 Main Output: Adjusts level for rear output ports 1 & 2.

Headphone Output Knobs: Adjust volume for two
headphone outputs.
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Feature

Description

7

Headphone Outputs: Two 1/4-inch TRS jacks,
controlled by Headphone Output knobs (6).

M-AUDIO - FAST TRACK ULTRA © (BACK)

¢ N NV

Inputs
S 6 & 6

Always use “In” position on front
panel buttons to activate these
ports.

Feature Description

8 Phantom Power Switch: Sends 48V power to front
XLR inputs (for use with powered microphones).
Power Button: Press to power on the Fast Track

9 Ultra. The unit must be connected to the host
computer’s USB bus or the external power supply.

10 Power Supply Connector: Connect optional 9V DC
500mA power supply when using as stand-alone unit.
Line Outputs: Six balanced 1/4-inch (TRS) jacks

11 |provide analog outputs. Ports 1 and 2 are controlled by
front panel main output knob.

12 USB (2.0) Connector: Accepts standard USB cable
from host computer.

13 |MIDI Inputs: Not supported by Concert.

14 |S/PDIF Outputs: Not supported by Concert.

15 Line Inputs: Six 1/4-inch TRS jacks provide balanced/
unbalanced analog inputs.

16 |Inserts: Not supported by Concert.
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DEVICE DRIVERS

You can find the latest device drivers for M-Audio © products on

their company website:

1. Inthe Address field of your browser, type
http://www.m-audio.com/ and then press Enter.

2. Under Quick Links, choose Drivers/Updates. The Drivers and
Software Search page appears.

Drivers/Updates Manualz

Drivers and Software Search

USE Audio Series -

Control Surfaces
Keyboard Series
Midizport Series
Rewvolution Series
DJ

MicroTrack
Software Series
Microphone Series
Miscellaneous

m

Audiophile USB

Fast Track
|FastTrackPro
Fast Track Ultra

Fast Track Ultra 8R

Fast Track USB

Groove Lab

Jamlab

KeyStudio 49

M-Audio Black Box

Windows XP SP3

Windows XP SP2
Windows Vista 32-Bit
Windows Vista 32-Bit SP1
Windows Vista 32-Bit SP2
Windows Vista 54-Bit
Windows Vista 54-Bit SP1
Windows Vista 84-Bit SP2
Windows 7 32-Bit

Windows 7 54-Bit

»

e, |

sizcox €

Figure 3-1: Device Driver Search

In the left-hand panel, choose USB Audio Series.

In the center panel, choose your device model (e.g., Fast

Track Pro).

5. In the right-hand panel, choose your operating system (e.g.,

Windows XP SP2).

6. The driver file appears in the Results area, at the bottom of the

page.

7. Click on the filename. Completion of the survey is optional and
is not required to download the driver.

8. Scroll down to the bottom of the survey. To download the
driver, click on the filename.

© 2009 Avid Technology, Inc. Used with permission.
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http://www.m-audio.com/

The following dialog appears:

File Download - Security Warning ﬁ

Do you want to run or save this file?

Type: Application, 7.62MEB
From: www.m-audio.com

@ Mame: FastTrackPro_6_0_2 5 10_0_5134.exe

Run ][ Save ] [ Cancel ]

patentially ham your computer. f you do not trust the source, do not

rﬁ] While files from the Intemet can be useful, this file type can
L
\—*/)l run ar save this software. YWhat s the risk?

Figure 3-2: Device Driver Installation

9. Click Run to install the driver.
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TROUBLESHOOTING

This chapter provides information on adjusting the Concert Client
setup and troubleshooting problems with the Concert Client.

MESSAGES AND NOTIFICATIONS

1. Warning: Cannot find any audio device. You must configure
your sound device and try again.

2. Warning: Cannot load your sound device. You must configure
your default sound device and try again.

3. Warning: Cannot load your sound device. You must confiqure
your default sound device and try again.

4. You have been disconnected: This user was logged in on
another computer.

5. Login time-out: Cannot perform login. Verify the media server
port, or your network connection, and try again. Contact your
system administrator if your problem persists.

6. Login time-out loading user data: Your network connection may
be too slow. Please try again or contact your system
administrator.

7. Your username and password were not recognized. Please
check and try again.

8. No role associated to this username. Please contact your
system administrator.

9. Maximum number of users exceeded in the system. Please
contact your system administrator.

10. Trial period has expired. Please contact your system
administrator.

11. Connection to Login Server failed. Check Login Server
address and port, or your Network Connection, and try again.

12. Connection to Media Server failed. Check Media Server
Address, or your Network Connection, and try again.
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FAQS
13. My headset is not working. What’s wrong (can’t hear, etc.)?
14. My audio is choppy. What should | do?

15. How can | adjust my sound options?

SOUND DEVICE PROBLEMS

1. Received error message “Warning: Cannot find any audio
device. You must configure your sound device and try
again.”

This message is displayed when Concert Client tries to load a
sound device and cannot find any. You need to install a sound
card or USB headset in order to use Concert Client.

2. Received error message “Warning: Cannot load your
sound device. You must configure your default sound
device and try again.

This message is displayed when Concert Client tries to load a
sound device that is not configured in Windows. Example: The
first time you start Concert Client, you are using a Plantronics
Device. You quit Concert Client, you unplug the Plantronics device
then you restart Concert Client. Concert Client tries to load the
Plantronics device but does not succeed and instead uses the first
sound device that Windows detects.

3. Received error message “Warning: Cannot load your
sound device. You must configure your default sound
device and try again.

This message is displayed when the sound device in use is
unplugged while Concert Client is open. Concert Client will
automatically switch to the next available sound device. You can
reconfigure the device through the configuration.

CLIENT CONNECTIVITY

4, Received notification “You have been disconnected: This
user was logged in on another computer.”

This message is displayed when a user is already logged in, and
tries to log in to Concert Client from another location (another
computer).
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5. Received notification: “Connection to login server failed.
Check login server address and port, or your network
connection, and try again.”

This message is displayed when the Concert client cannot reach
the EMS server. This may be due to one or more reasons (not
limited to the following):

e The Login Server address and/or Port are wrong. To check
the login address and port, click on Config -> Server-
>Advanced. Make sure the Login Server Address and
Port are set exactly as specified by the system
administrator.

e The network connection is broken. This may be due to one
or more of the following conditions:

— Loss of connection to your ISP

— Network cable unplugged

— Improper network settings on your PC

— Incorrect firewall setup by the system administrator
— Blocked by locally running firewall software.

6. Received error notification: “Login time-out: Cannot
perform login. Verify the media server port, or your
network connection, and try again. Contact your system
administrator if your problem persists.”

This message is displayed under two conditions. If the media
server port is wrong or if the network (LAN) is very slow. To check
the media port, click on Config -> Server->Advanced. Make sure
the Media Server Port is set correctly. Contact your system
administrator for the exact value (the default value is 6001).

7. Received notification: “Login time-out loading user data:
Your network connection may be too slow. Please try
again or contact your system administrator.”

This messages means that the login was successful, but due to
abnormal network conditions (e.g., network too slow), Concert
Client timed out while receiving setup information from the server.
Contact your network administrator if the problem persists.

8. Received notification: “Your username and password
were not recognized. Please check and try again.”

This means you have entered the wrong username, the wrong
password, or both. It may also mean that this user name does not
exist in the database. If the problem persists, contact the system
administrator.
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9. Received notification: “No role associated to this
username. Please contact your system administrator.”

This messages means that your username and password were
entered correctly, but your account is not associated to any role. A
user must belong to a role before access can be granted to the
Concert system. Contact the system administrator.

10. Received notification: “Maximum number of users
exceeded in the system. Please contact your system
administrator.”

This message indicates that the number of Concert users
currently within the database exceeds the allowed number of
licensed users. This can occur if the database is restored from an
archive containing more than the licensed number of users.
During this state, users will be denied access to Concert until the
administrator does one of the following:

e Delete excess users from the system, so that the number
of users equals the number allowed by the license key

¢ Update the license key

e Contact Clear-Com for details on purchasing a new license
key.

11. Received notification: “Trial period has expired. Please
contact your system administrator.”

This message means that the trial period (60 days) has expired.
To continue using Concert, the system administrator will need to
contact Clear-Com for details on purchasing a license key.

12. Received notification: “Connection to media server failed.
Check media server address, or your network connection,
and try again.”

This message is displayed if the media server address is wrong.
To check the media address, click on Config -> Server-
>Advanced. Make sure the Media Server Address is set correctly.
Contact your system administrator for the exact value.

AUDIO PROBLEMS

13. My headset is not working. What’s wrong (no audio, etc.)?

e Check that the headset is correctly plugged-in and perform
a Test Primary Devices in Config > Devices (see p. 1-7).

e Verify mixer settings for both your input and output devices
(also verify that you are not muted).
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¢ Verify that the appropriate device is selected within the
client window (i.e., primary or secondary device).

e Verify that the recipient’s audio device configuration has
also been checked.

14. My audio is choppy. What should | do?

e Check your audio settings in Config > Audio (see below).

SIMPLE MODE

The configuration options that are available in simple mode will
normally be sufficient to solve your problems.

a. Verify your Network Settings. Make sure you specify the
appropriate network type. An incorrect configuration is the
primary cause for poor audio quality:

LAN: Corporate LAN with high and stable bandwidth
available. If set to LAN, but you are in fact on the
Internet (e.g., home, hotel, airport), you may
experience choppy audio and/or packet loss.

WAN: Corporate WAN (controlled network
environment). However, your bandwidth may be lower
between two offices or sites.

Internet: Uncontrolled, unstable, and low bandwidth
available.

b. Verify your Options Settings:

Echo Cancel: Reduces echo. Useful when Concert
Client is used with speakers.

Noise Filter: Reduces background noise.
Auto Gain Control: Auto-adjusts microphone volume.

Audio Buffer: Windows Sound Channel Buffers. On
slow computers or with the Windows Vista operating
system, increasing Audio Buffer increases audio
guality. On Vista, this value must be over 8. For
Windows XP, a value of 5 is generally sufficient, but
you may need to increase it on slower computers.

Note: Increasing the Windows Sound Buffer may also increase the
audio delay.
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ADVANCED MODE

This mode provides more options for experienced users.

c. Verify your Bandwidth Settings: High/Medium/Low
settings.

Make sure you choose the value corresponding to the
available bandwidth. If you choose High, audio quality will
be better only if you have enough bandwidth. Otherwise, it
can become choppy.

d. Verify your Min and Max Jitter: settings.

Audio jitter buffer setting specifies the amount of audio
data held in the buffer before the audio data is played. Its
goal is to minimize the effect of network congestion on
audio quality:

— If you have a slow connection, select a higher Min. and
Max. Jitter (e.g., 80-200 ms),

— For a high bandwidth, 40-80 ms should be fine.

e. Verify your Loss Protection: Off/lLow/Medium/High
settings.

— Loss protection provides a system to recover packets
lost during network transit. If you experience poor
audio quality, you may want to increase this value.

— On aLAN, it may be set to “Off”.

— If you are connected through the Internet (slow
bandwidth), we recommend that you choose “Medium”.

Note: Inthe case that the Network Connectivity icon is consistently
displaying either a yellow or red circle, downgrade your
network setting to either WAN or Internet to improve your
audio quality.

15. How can | adjust my sound options?

You can select devices in Concert Client through the Config >
Devices menu option or by selecting the Configuration icon on
the Client status bar.

Make sure that you are using the correct devices, and verify which
of the primary or secondary devices you are currently using.

Clear-Com Communication Systems
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LIMITED WARRANTY

This document details the Clear-Com Standard Limited Warranty for all new products for sale
within all regions with the exception of Military, Aerospace, and Government (MAG).

EXCEPT AS SET FORTH HEREIN ("LIMITED WARRANTY"), CLEAR-COM MAKES NO
OTHER WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT
LIMITATION ANY WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT OF THIRD
PARTY RIGHTS, OR FITNESS FOR A PARTICULAR PURPOSE, ALL OF WHICH ARE
EXPRESSLY DISCLAIMED.

1. Standard Limited Warranty. Clear-Com Communication Systems ("Clear-Com") warrants its
products, including supplied accessories, against defects in material or workmanship for the

time periods as set forth below provided it was purchased from an authorized Clear-Com
dealer or distributor.

a) Pursuant to this Limited Warranty, Clear-Com will, at its option:
i) repair the product using new or refurbished parts, or;

ii) replace the product with a new or refurbished product.

b) Remedies: In the event of a defect, the rights detailed in 1 (a) are your exclusive
remedies. For purposes of this Limited Warranty, "refurbished" means a product or part
that has been returned to its original specifications.

c) Standard Warranty Period (by Product):

i) All Clear-Com brand systems and products, including belt packs, have a Limited
Warranty of two years, with the exception of;

(1) Cables, accessories, components & consumable items have a Limited
Warranty of 90 days.

(2) Any Clear-Com product that has been classified as obsolete at the time of sale
has a Limited Warranty of 90 days from sales and will be replaced with the
same product or a sales credit will be issued, at the sole discretion of Clear-
Com.
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(3) Headsets, handsets, microphones, and associated spare parts, as well as UHF
wireless IFB products, have a Limited Warranty of one year.

(4) UHF WBS Analog wireless intercom systems have a Limited Warranty of three
years.

(5) All software products, including Concert (Client and Server), ECS, Production
Maestro and Logic Maestro are warranted for one year and shall substantially
conform to published specifications. The media on which the Software is
furnished is warranted to be free of defects in material and workmanship (under
normal use) for a period of one year.

(6) Any Clear-Com products that are listed within the last time buy period have the
same Limited Warranty for their type 1.i.1 - 1.i.5 as above.

d) Any Clear-Com product that is repaired or supplied as a replacement under the terms of
this Limited Warranty shall inherit the remaining warranty period from the original
product.

e) Standard Warranty Period Start Date

i) Dealer / Distributor Sales: In view of Dealer or Distributor stocking practices, the
Standard Warranty Period for products sold through Dealers or Distributors will
commence from the Clear-Com invoice date and will include an automatic
extension of three months. Any valid warranty claim within the Standard Warranty
Period as determined by the Clear-Com invoice date will be covered without further
supporting evidence. All warranty claims after this date must be supported by the
Customer's proof of purchase that demonstrates the product is still within the
Standard Warranty Period (as detailed in Section 1.c.i above, plus the automatic
three month extension) from their purchase date.

i) Direct Sales: The Standard Warranty Period will commence from the date the
product was shipped from Clear-Com to the Customer. The Standard Warranty
Period start date for contracts that include commissioning will be the date of the
Site Acceptance Test (SAT) or one month from conclusion of the commissioning
project, whichever is earlier.

f) Invalidation of Warranty

i) This Limited Warranty shall be invalidated if the product's outer case has been
opened and internal modifications have been made or damage has occurred, or
upon the occurrence of other damage or failure not attributable to normal wear and
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tear. Authorized modifications with Clear-Com's express written permission will not
invalidate the warranty.

g) Software Updates

i) Software Updates are released periodically to correct discovered program bugs.
During the Warranty Period, software updates are available to Customers free of
charge.

h) Software Upgrades

i) Software Upgrades include new Features and/or Functional Enhancements and are
not included as part of the Standard Warranty but may be purchased at the
published rates.

i) Note: Inthe absence of a Software Update containing a program correction and no
available workaround to mitigate the problem, at the discretion of Service, Sales,
Engineering, or Product Management, the Customer may be provided a Software
Upgrade under warranty.

2. Exclusions. Services do not cover damage or failure caused by any occurrence beyond
Clear-Com's reasonable control, including without limitation acts of God, fire, flooding,
earthquake, lightning, failure of electric power or air conditioning, neglect, misuse, improper
operation, war, government regulations, supply shortages, riots, sabotage, terrorism,
unauthorized modifications or repair, strikes, labor disputes or any product failure that Clear-
Com determines is not a result of failure in the Services provided by Clear-Com. Further
Services excluded from this Agreement include: services required due to errors or omissions
in Customer purchase orders; installation or maintenance of wiring, circuits, electrical
conduits or devices external to the products; replacement or reconditioning of products which,
in Clear-Com's opinion cannot be reliably maintained or properly serviced due to excessive
wear or deterioration; Customer's failure to maintain the installation site in accordance with
the environmental specifications of the products; or service on products removed from the
location originally specified by Customer and/or reinstalled without the prior written approval
of Clear-Com. Customer will pay Clear-Com's then current published charges to restore such
Covered Products to a condition eligible for further service under this Agreement. Clear-Com
shall be excused from and shall not be liable for any failure or delay in performance under
this Agreement due to the foregoing or any causes beyond its reasonable control.

3. Limitation of Liability. IN NO EVENT WILL CLEAR-COM BE LIABLE UNDER THIS
AGREEMENT FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS), REGARDLESS OF
THE FORM OF ACTION, EVEN IF ADVISED IN ADVANCE OF THE POSSIBILITY OF
SUCH DAMAGES.
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4. Assignment. Neither party may assign this Agreement or any portion thereof without the
prior written consent of the other, except in the event of a merger, sale of all or substantially
all of the assets or other corporate reorganization.

5. Ownership of replaced parts or product. All replaced parts or products become the
property of Clear-Com.

6. Entire Agreement. This Agreement constitutes the entire agreement between the parties
with respect to the subject matter hereof, and supersedes all prior or contemporaneous
proposals, oral or written, and all other communications between them relating to the subject
matter of this Agreement.
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TECHNICAL
SUPPORT & REPAIR
POLICY

NOVEMBER 1, 2008

In order to ensure that your experience with Clear-Com and our World Class products is as
beneficial, effective and efficient as possible, we would like to define the policies and share
some "best practices" that can accelerate any problem solving processes which we may find
necessary and to enhance your customer service experience. Our Technical Support, Return
Material Authorization, and Repair Policies are set forth below. These Policies are subject to
revision and constantly evolve in order to address our Customers' and the Market's needs.
Accordingly these are provided by way of guidance and for information only and may be
changed at anytime with or without Notice.

TECHNICAL SUPPORT POLICY

a) Telephone, online, and e-mail technical support will be provided by the Customer Service
Center free of charge during the Warranty Period.

b) Technical support will be provided free of charge for all software products under the
following conditions:

i) The application, operating, and embedded software is installed on a product
covered by Clear-Com's Limited Warranty, and:

(1) The software is at the current release level; or,
(2) The software is one (1) version removed from current.

ii) Older versions of software will receive "best-effort" support, but will not be updated
to correct reported bugs or add requested functionality.

c¢) For Technical Support:
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i) North and South America, (inc. Canada, Mexico, and the Caribbean) & US Military:

Hours:
Days:
Tel:
Email:

0800 - 1700 Pacific Time
Monday - Friday
+1 510 337 6600

CustomerServicesUS@vitecgroup.com

i) Europe, the Middle East and Africa:

i) Asia-Pacific:

Hours:
Days:
Tel:
Email:

Hours:
Days:
Tel:
Email:

0800 - midnight Central European Time
Monday - Friday

+49 40 853 999 700
TechnicalSupportEMEA@Vvitecgroup.com

0800 - 1700 Pacific Time
Monday - Friday
+1 510 337 6600

CustomerServicesAPAC@vitecgroup.com

d) Email Technical Support is available for all Clear-Com branded products free of charge
for the life of the product, or two years after a product has been classified as obsolete,

whichever comes first.

e) Support for Distributor and Dealer Sales

i) Distributors and Dealers may utilize the Customer Service Centers once a system

f) Support for Direct Sales

has been installed and commissioned. Clear-Com Systems and Applications
Engineers will provide support to the Distributor from the pre-sales stage through to
satisfactory installation for new system purchases. Customers will be encouraged
to contact their Dealer or Distributor with their installation and technical support
enquires rather than using the Customer Service Centers directly.

Customers may utilize the Customer Service Centers once a system has been
installed and commissioned by Clear-Com Systems and Applications Engineers, or
in the case of project installations, once the Project Team has completed the hand-
over to the Support Centers.

Vi
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RETURN MATERIAL AUTHORIZATION
POLICY

a) Authorizations: All products returned to Clear-Com or a Clear-Com Authorized Service
Partner must be identified by a Return Material Authorization (RMA) number.

b) The Customer will be provided with an RMA number upon contacting Clear-Com Sales
Support as instructed below.

¢) The RMA number must be obtained from Clear-Com via phone or email prior to returning
product to the Service Center. Product received by the Service Center without a proper
RMA number is subject to return to the Customer at the Customer's expense.

d) Damaged equipment will be repaired at the Customer's expense.
e) Returns are subject to a 15% restocking fee.

f) Advance Warranty Replacements (AWRS);

i) During the first 30 days of the Standard Warranty Period: Once the equipment fault
has been verified by Clear-Com or its authorized representative, Clear-Com will
ship a new replacement product. The Customer will be provided with an RMA
number and be required to return the faulty equipment within 14 days of receipt of
the replacement or will be invoiced for the list price of a new product.

i) During days 31-90 of the Standard Warranty Period: Once the equipment fault has
been verified by Clear-Com or its authorized representative, Clear-Com will ship a
like-new, fully refurbished replacement product. The Customer will be provided with
an RMA number and be required to return the faulty equipment within 14 days of
receipt of the replacement or will be invoiced for the list price of a new product.

iif) To obtain an RMA number or request an AWR:

(1) North and South America, Asia-Pacific, and US Military:

Hours: 0800 - 1700 Pacific Time

Days: Monday - Friday

Tel: +1 510 337 6600

Email: SalesSupportUS@vitecgroup.com
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(2) Europe, the Middle East and Africa:

Hours: 0800 - 1700 GMT + 1

Days: Monday - Friday

Tel: + 44 1223 815000

Email: SalesSupportEMEA@vitecgroup.com

iv) Note: AWRs are not available for UHF WBS Analog wireless intercom systems.
UHF WBS Analog wireless intercom systems out-of-box failures must be returned
to Alameda for repair.

v) Note: Out-of-box failures returned after 90 days will be repaired and not replaced
unless approved by Clear-Com Management.

vi) Note: AWRs are not available after 90 days of receipt of product unless an AWR
Warranty Extension is purchased at the time of product purchase.

vii) Note: Shipping charges, including duties, taxes, and insurance (optional), to Clear-
Com's factory is the responsibility of the Customer. Shipping AWRs from Clear-
Com is at Clear-Com's expense (normal ground or international economy delivery).
Requests for expedited shipping (e.g., "Next-Day Air") and insurance are the
responsibility of the Customer.

REPAIR POLICY

a) Repair Authorizations: All products sent to Clear-Com or a Clear-Com Authorized
Service Partner for repair must be identified by a Repair Authorization (RA) number (see
above).

b) The Customer will be provided with an RA number upon contacting Clear-Com Customer
Services as instructed below.

c) The RA number must be obtained from Clear-Com via phone or email prior to returning
product to the Service Center. Product received by the Service Center without a proper
RA number is subject to return to the Customer at the Customer's expense.

d) Return for Repair

viii
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i) Customers are required to ship equipment at their own cost (including
transportation, packing, transit, insurance, taxes and duties) to Clear-Com's
designated location for repair.

(1) Clear-Com will pay for the equipment to be returned to the Customer when it is
repaired under warranty.

(2) Shipping from Clear-Com is normal ground delivery or international economy.
Requests for expedited shipping (e.g., "Next-Day Air") and insurance are the
responsibility of the Customer.

i) Clear-Com does not provide temporary replacement equipment ("loaner")
during the period the product is at the factory for repair. Customers should
consider a potential prolonged outage during the repair cycle, and if required for
continuous operations purchase minimum spare equipment required or purchase
an AWR Warranty Extension.

iii) No individual parts or subassemblies will be provided under warranty, and warranty
repairs will be completed only by Clear-Com or its Authorized Service Partners.

iv) Customers requesting a non-warranty repair will be provided an estimate of the
total repair cost prior to the return of the equipment. In the event that Clear-Com is
unable to estimate the cost of repair, the Customer may elect to return the product
to the factory for an estimate. The Customer is responsible for shipping costs both
to and from the factory in the event they choose not to accept the estimate.

v) The Customer must provide either a purchase order for the repair work, or will be
required to make an advance payment (as a debit against the Dealer's line of
credit, or credit card) prior to the repaired product being returned to the Customer.

vi) For requesting a Repair Authorization number:

(1) North and South America, Asia-Pacific, and US Military:

Hours: 0800 - 1700 Pacific Time

Days: Monday - Friday

Tel: +1 510 337 6600

Email: CustomerServicesUS @vitecdgroup.com
(2) Europe, the Middle East and Africa:

Hours: 0800 - midnight Central European Time

Days: Monday - Friday
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Tel: +49 40 853 999 700
Email; TechnicalSupportEMEA@Vvitecaroup.com

vii) Note: Clear-Com's Limited Warranty does not cover normal wear and tear. The
Customer will be charged the full cost of the repair if their equipment has been
tampered with by non-approved personnel, or has been subject to damage through
electrical failure, liquid damage or mishandling. The Customer Service Center will
provide the Customer with a cost estimate for any such repairs prior to undertaking
the work.
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